Welcome to AxiDraw!

You’re one of the first to get one of our new personal writing and drawing machines. This guide is here to help you get started. There is a lot here—covering how you set up and use the machine, and pointing you about where to go from here.

However, this guide is still a work in progress, and we you may wish to check back soon for the latest version.

We are planning several additions to this guide in the coming months, both adding clarifications in response to feedback, and adding some additional sections that are already planned. We are planning additional sections on performance tuning, specific work flows, and hope to add more concrete examples and videos as well.

Recent changes to this guide include updates to the current software version, which is v1.2.2.

You can download the latest version of this at http://axidraw.com/guide

Look at the front cover of the guide to find the date and version number of the guide that you are looking at.
## Contents

0. This guide is a work in progress! ........................................ 2
1. Introducing the AxiDraw ............................................... 5
   1.1 Credits and History ............................................... 5
2. Checking out your AxiDraw ........................................... 6
   2.1 What comes with the machine ................................. 6
   2.2 AxiDraw Anatomy................................................. 6
   2.3 Safe handling of the AxiDraw ................................. 8
3: Overview: Getting Started with AxiDraw ......................... 9
4: Software for AxiDraw .................................................. 10
   4.1 Installing software .............................................. 10
   4.2 Inkscape and the extensions ................................. 10
   4.3 Aside: Alternative software and APIs ..................... 10
5: The Home Corner ..................................................... 11
6: Workholding ........................................................... 12
   6.1 Printing on with large workpieces .......................... 12
   6.2 Workholding with the Clip Easel ............................ 12
   6.3 Moving beyond the Clip Easel ............................... 13
7: Connecting Power and USB .......................................... 14
8: Pens and Getting Ready for Printing .............................. 15
   8.1 Pen choices ....................................................... 15
   8.2 Setting the pen angle .......................................... 15
   8.3 Inserting a pen .................................................. 16
   8.4 Pen up and pen down positions .............................. 17
   8.5 Positioning your paper ........................................ 19
   8.6 Summary .......................................................... 21
9: Plotting with the AxiDraw ............................................ 21
   9.1 Making your first plot ......................................... 21
   9.2 Pausing, resuming, and canceling plots .................... 24
   9.3 Plotting with multiple layers and colors ................... 25
   9.4 Basic speed control ........................................... 27
   9.5 Pen lift speeds .................................................. 28
   9.6 Advanced options .............................................. 29
   9.7 AxiDraw Manual Controls .................................... 30
   9.8 Plotting away from home .................................... 32
10: Designing for AxiDraw ........................................ 33
  10.1 General considerations ........................................ 33
  10.2 Visualizing paths in your document ...................... 34
  10.3 Working with standard fonts ............................... 34
  10.4 Single stroke fonts & Hershey Text ........................ 36
  10.5 Capturing a signature ........................................ 37
  10.6 Aside: On automatic tracing of handwriting .......... 37
  10.7 Filling text and shapes .................................... 38

11: Maintenance and troubleshooting .......................... 39
  11.1 The hex wrenches ............................................ 39
  11.2 Lubrication .................................................. 39
  11.3 Belt tension .................................................. 39
  11.4 Loss of position ............................................. 39
  11.5 Service, repair, and parts support ....................... 40

12. AxiDraw Tips and Tricks ........................................ 40
1. Introducing the AxiDraw
The AxiDraw is a simple, modern, precise, and versatile pen plotter, capable of writing or drawing on almost any flat surface. It can write with your favorite fountain pens, permanent markers, and other writing implements to handle an endless variety of applications. Its unique design features a writing head that extends beyond the machine, making it possible to draw on objects bigger than the machine itself.

The AxiDraw is an extremely versatile machine, designed to serve a wide variety of everyday and specialized drawing and writing needs. You can use it for almost any task that might normally be carried out with a handheld pen.

It allows you to use your computer to produce writing that appears to be handmade, complete with the unmistakable appearance of using a real pen (as opposed to an inkjet or laser printer) to address an envelope or sign one’s name. And it does so with precision approaching that of a skilled artist, and — just as importantly — using an arm that never gets tired.

1.1 Credits and History:
While new to most of the world, the AxiDraw project has been active since 2014, when it was first created by Dr. Lindsay Robert Wilson of IJ Instruments Ltd. in the UK.

Early AxiDraw units had a different design. It was a smaller format pen plotter with a chassis made from machined Delrin plastic. It had two independent timing belts, one driven by a stepper motor on the base, and the other by a stepper motor on the moving carriage. For software, it used a modified version of the WaterColorBot driver developed at Evil Mad Scientist Laboratories.

In 2015, Wilson began collaborating with Windell Oskay and Lenore Edman of Evil Mad Scientist Laboratories towards a new AxiDraw model – now before you – that would be principally designed and manufactured in the USA.

The new AxiDraw was enlarged to reach twice the travel area, to cover a full page of A4 or US Letter paper. Its geometry was changed to use a single drive belt, with two larger stepper motors stationary on the base. Its major components would now be made of aluminum (machined or stamped and folded), and the new pen holder could be mounted vertically or at 45° to the paper.
2. Checking out your AxiDraw

1. The AxiDraw itself (Ready to use)
2. Clip Easel and binder clips (4)
3. USB cable
4. Hex drivers, including 5/64”, 3/32”, and 1/8”
5. Plug-in power supply. (9 V, 1.5 A, worldwide input)
6. Not shown: Rubber bands

2.1 What comes with the machine

Here are the parts that come with the AxiDraw:

1. The AxiDraw itself (Ready to use)
2. Clip Easel and binder clips (4)
3. USB cable
4. Hex drivers, including 5/64”, 3/32”, and 1/8”
5. Plug-in power supply. (9 V, 1.5 A, worldwide input)
6. Not shown: Rubber bands

2.2 AxiDraw Anatomy

Let’s also look at what the different parts of the machine are called. We will refer to many of these parts by their names elsewhere.
§2.2, *AxiDraw anatomy, continued:*

Top View

- Y Tail Block
- Y Shafts
- Timing belt
- Carriage (Y-axis part)
- X Shafts
- Wire conduit

Detail: Left Base

- "EBB" Control board
- Stepper motor
- Power Jack
- USB Port
- Base Block (left)
- Rubber Feet
- Pause Button (aka “PRG” button)
2.2, AxiDraw anatomy, continued:

Detail: Pen holder

- Belt
- Vertical slide
- Y Shafts
- Pen-lift servo motor
- Y Tie Block
- Vertical shafts
- Pen Clip
- Screws
- Y Shafts
- Belt

2.3 Safe handling of the AxiDraw

1). **Lifting**: Lift AxiDraw by the base blocks, or by the stepper motors or X shafts if necessary. Do not lift by the cables, carriage(s), cable guides, or pen holder.

2). **Heat**: Please note that the two stepper motors may get warm. This is normal, but it is helpful to be aware of it. They should not get too hot to touch.

3). **Moving parts**: AxiDraw has exposed moving parts. Keep fingers, hair, and other things that could get caught, crushed, or tangled safely away from the belt and the pinch points between the moving carriage, the pen holder, and the motors.

⚠️ Warning: Keep fingers away from pinch points while AxiDraw is operating.
3: Overview: Getting Started with AxiDraw
In brief, here are the steps to getting started with the AxiDraw:

1) Install the software.
2) Open or create the artwork that you would like to print.
3) By hand, move the carriage to the upper-left Home Corner.
4) Connect power and USB cables.
5) Check pen-up and pen-down heights.
6) Set up your pen and paper.
7) Begin plotting from within the AxiDraw software.

Part 4 of this guide goes through the first item on the list: Installing the software. Parts 5 through 8 go through setting up your AxiDraw for use. Part 9 walks through making your first plot, and various options available while plotting. Part 10 talks about designing for AxiDraw. It is followed by sections on various tips and tricks for using your machine.
4: Software for AxiDraw

4.1 Installing software
You will need to install software on your computer to operate the AxiDraw. Current instructions and download links are available at: http://axidraw.com/sw

From there, follow the directions specific for your operating system:
• For Mac and Windows, there are easy installers that you can download.
• For Linux, one or more manual steps are required.

The software that you will install includes Inkscape, the superb (and free) drawing program, and a set of extensions that operate the AxiDraw from within Inkscape.

4.2 Inkscape and the extensions
Once you have installed the software, launch Inkscape.
The AxiDraw software may be found in the Extensions > AxiDraw submenu of Inkscape. All machine control is performed from within the “AxiDraw Control” panel. (A second extension, Hatch Fill, is provided as well, to help with filling in shapes.)

4.3 Aside: Alternative software and APIs
RoboPaint is an alternative driver software available for painting and drawing robots. It requires a separate install process, but does support AxiDraw.

Programming is not required to operate the AxiDraw. However, all of our software is open source. And, if you would like to program it or remotely send data to it, we do have interfaces and documentation available.

For more information about RoboPaint or our APIs, please see the documentation on our wiki site at http://axidraw.com/docs

Beyond these options, a stand-alone command line version of our (otherwise) Ink- scape-based software is in development, and available in beta to AxiDraw users. If you would like early access, please contact us directly: https://shop.evilmadscientist.com/contact
5: The Home Corner
Before you start plotting, the pen holder must be moved to the Home Corner. This is as far left and as far back as it will go: where the pen holder is closest to the left base (with the AxiDraw logo, and the USB port).

When a plot finishes, the AxiDraw will return to its Home Corner automatically, leaving it ready for the next plot.

Slide the carriage to the Home Corner by hand. You can move it diagonally by holding the Y Tie Block, which is the black block just behind the pen holder. Do not push the pen holder directly.

The carriage can only be moved when the power to the motors is off. If it does not move easily, turn off the motors so that you are not trying to force them. To do so, use the “Raise pen, turn off motors” command in the Setup tab of AxiDraw Control (see page 17). If necessary, you can also physically disconnect the AxiDraw from power.
6: Workholding

Whatever workpiece the AxiDraw is to write or draw upon – whether that is paper, wood, or cookies – needs to be reasonably fixed in place so that it does not move while plotting.

6.1 Printing on with large workpieces

For large workpieces such as poster boards or cardboard boxes, the AxiDraw may be placed directly on top of the workpiece. Other examples of large workpieces that AxiDraw can sit upon might include things like fabric, wooden surfaces, or large whiteboards.

Some workpieces, such as this small dry-erase whiteboard, are awkward to work with: Tall, but not wide enough for the AxiDraw to sit on top of. In cases like this, you may need to prop up the base of AxiDraw to make it tall enough to reach.

6.2 Workholding with the Clip Easel

A simple board with clips, the Clip Easel, is included with the AxiDraw for holding smaller workpieces – principally different shapes and sizes of paper – that are not large enough to be held down by the AxiDraw itself. This is a great way to mount paper when getting started with the AxiDraw.

The Clip Easel is 9 × 12 inches (about 23 x 30 cm) in size, with rubber feet and four small binder clips. You can mount different sizes of to it, including US letter size (or A4) paper, and smaller sizes including envelopes, cards, and invitations. (With smaller paper, you can also potentially mount several pieces at the same time.) The clips can be positioned as needed to hold the paper flat, and avoid the areas where you will be writing.
The examples shown above are:

A) A certificate to be filled out (Letter size, landscape orientation)
B) Mailing address (#10 envelope, landscape orientation)
C) A formal invitation (6 ⅜ × 8 ⅞ inch, portrait orientation)
D) A page of mixed text and drawing (Letter size, portrait orientation)

In every case, line up the corner of the paper with the upper left corner of the Clip Easel, such that the corner of the paper is closest to the Home Corner.

If your document is wider than it is tall (or square), it is said to be in landscape orientation, and your paper should be oriented as in examples A and B above. If is taller than it is wide, it has portrait orientation; turn your paper “sideways” as in examples C) and D) above. (This default behavior can be overridden. See “9.6 Advanced options” on page 29.)

6.3 Moving beyond the Clip Easel
While the Clip Easel is versatile, its use is entirely optional. Paper can be also held in place with tape, clamps, tacks, other types of clipboards, and by other means as necessary.

If your AxiDraw is used as a single-purpose machine (that is, if you use the same pen and paper size consistently), you will likely prefer to make a workholding solution tailored for your specific application. For example, you might use multiple clip easels (or similar boards) with endstops that hold them in place. Or perhaps standard clipboard, permanently mounted to a tabletop or work surface. Dedicated solutions like these can make it much faster to swap paper in and out for printing.
In the next section, when setting the pen heights, it is necessary to plug in the AxiDraw. When it is time to do so, connect the power and USB cables to the AxiDraw as shown. Connect the USB cable to any available USB port on your computer.

The plug-in power adapter included with the AxiDraw (9 V dc, regulated, center positive) works with worldwide mains power (100-240 V ac). Outside of the US, it may require an inexpensive plug-shape adapter.

Once your cables are connected, make sure that the AxiDraw has room to move. As the carriage moves, it’s important that it cannot get caught on stray cables.
8: Pens and Getting Ready for Printing

In this section we will discuss different types of pens, configuring the pen to be vertical or at an angle, the pen-up and pen-down positions, setting the pen height, and how to set the paper position relative to the pen.

8.1 Pen choices
The pen holder on the AxiDraw fits pens up to ⅝ inch (16 mm) in diameter. The maximum recommended pen weight is 1.6 oz (45 g). The design is such that the pen rests on the surface by its own weight. That allows it to ride over surfaces that are textured or otherwise uneven, however it also means that the pen holder does not apply significant downward pressure.

Good choices for pens to use include fountain pens, permanent markers, rollerball pens, technical pens, (small-bodied) whiteboard markers, liquid chalk markers, and other writing and drawing instruments that do not require significant downward pressure. While we refer to writing and drawing instruments as “pens” to be concise, other instruments such as automatic pencils, chalk, charcoal, and brushes can also work well in many cases. Others, like ball point pens may work inconsistently because they require a substantial amount of downward pressure to operate.

8.2 Setting the pen angle
The pen may be mounted vertically or diagonally at 45° to the paper by mounting the Pen Clip in either the vertical or angled position.
To detach the pen clip, loosen and remove the two black M3 screws on the front of the pen clip, using the 5/64” (2 mm) hex wrench, which has a ball end for easy access. Use the same two screws to reattach the pen clip, either in the vertical or diagonal orientation.

The 45° angle position is optimal for use with fountain pens, but will work well with most rollerball and fine point markers. The vertical position is more suited to markers with fatter tips or writing instruments that require more downward pressure.
8.3 Inserting a pen
You can insert a pen – or other writing instrument that you are using – into the pen clip and tighten it in place with the thumbscrew. (If you are setting up for the first time, you may find the thumbscrew removed for shipping.)

Take care to only apply gentle force with the thumbscrew: You only need to immobilize the pen, so stop turning once you encounter moderate resistance.

When using any ink-based pen (whether rollerball, fountain pen, or permanent maker), it is helpful to “bleed” out the tip before writing. Try it by hand on a piece of paper, and make sure that ink is actually flowing.

Note on fragile or delicate pens: If you choose to use fragile pens (such as high-end fountain pens with celluloid barrels), exercise great care when inserting the pen. You may wish to wrap the barrel in a thin, soft cloth to avoid scratching, and use little or no pressure from the thumbscrew. Moderately priced fountain pens, like the Lamy Safari shown above, tend to be quite tough, and require little special treatment.
8.4 Pen up and pen down positions
In this step we will check the pen-up and pen-down positions.

First, connect power and USB (See “7: Connecting Power and USB” on page 14). Then, within Inkscape, open up AxiDraw Control. You can find it in the menu bar at:

Extensions > AxiDraw > AxiDraw Control

Click on the Setup tab:

Select the “Toggle pen between UP, DOWN” action, and click the Apply button. If your software is all installed correctly and everything is hooked up correctly, the pen lift motor will alternately move to the up or down positions each time that you press Apply.
§8.4, *Pen up and pen down positions, continued*

The pen-up and pen-down heights may each be adjusted between 0 and 100% to suit your needs. Higher percentage values lift the pen higher.

The factory-default values of 60% (up) and 40% (down) are a good starting point. Try also adjusting them to a different set of values (say, 70% and 30%, respectively) and apply, to see that the positions change when you adjust them. The pen holder should visibly move up and down as you raise and lower the pen holder.

While in the pen-up position, insert your pen and position it above your paper.

The vertical position of your pen should be approximately 1/8 to 1/4 inch (3 - 6 mm) above the surface of the paper. You can physically adjust the position of the pen with the thumbscrew, and/or change the positions from the Setup tab of AxiDraw Control.

Toggle also to the pen-down position. With the pen down, the pen should rest on the paper by its weight. If it does not, you may need to lower the pen-down position. (While testing, you can protect the paper that you will be writing upon with another sheet of paper, to avoid writing on your actual workpiece.)

Finally, return the pen holder to the pen-up position to position your paper for printing.

Once you are familiar with the process of inserting the pen and setting the height, this process can be reduced in practice to two steps:

1) Raise the pen holder to the pen-up position (if it is not already there).
2) Insert your pen.
8.5 Positioning your paper
With your pen at the HOME Corner, and the pen at an appropriate height, it is time to position the paper with respect to the AxiDraw. The printable area starts at the HOME Corner, and extends down and to the right from that point.

Plotting on large surfaces (where the AxiDraw sits directly on the surface): Position the AxiDraw such that the pen tip is at the upper left corner of the area that you intend to plot upon. The software will treat the corner of the page in your Inkscape document as Home Corner for the purpose of plotting.

Here is how the “page” printed above looks from within Inkscape:
§8.5, Positioning your paper, continued

Plotting on everything else (letters, envelopes, invitations, and other smaller items): Position the paper with its upper-left corner directly underneath the tip of the pen. Square the paper up so that its top edge is parallel to the X-Shafts of the AxiDraw.

As we discussed earlier (page 13), documents that are taller than wide are usually turned “sideways”, as in B above. Whether vertical or horizontal, it is always the corner of the paper closest to the Home Corner that one aligns below the tip of the pen.

For comparison, here are how those two documents look on the computer when setting up to print:

The absolute position of your paper with respect to the AxiDraw will vary, depending on the paper, the pen that you use, as well as the pen length if it is mounted at 45°. However, for any given pen and paper setup, it is likely to remain relatively consistent. (See “6.3 Moving beyond theClip Easel” on page 13.)
9: Plotting with the AxiDraw

9.1 Making your first plot
In this section we will walk through the steps to make your first plot on the AxiDraw. Finish installing the AxiDraw software (§4) before beginning here. In addition to what comes with the AxiDraw, you will need pen and paper.

Download the set of AxiDraw example files from [http://axidraw.com/ex](http://axidraw.com/ex)

The download is a small zip archive of example files. Open/unzip, and from within Inkscape open up the file called AxiDraw_First.svg. Once open, the document should look approximately like this:

If you cannot see the full page outline when you first open the file, select from the menu View > Zoom > Page, or type the number ‘5’ on your keyboard.

8.6 Summary
Your AxiDraw is now ready to print. To recap, the steps in getting ready are:
1) Move the pen holder to the Home Corner.
2) Connect Power and USB cables.
3) Use the software to move the pen holder to the “pen-up” position.
4) Insert the pen, just above the paper.
5) Position your paper with its corner beneath the tip of the pen.
§9.1, Making your first plot, continued

If you have not done so already, get the AxiDraw set up to print:

1) Slide the pen holder to the Home Corner. (See §5)
   • The Home Corner is the upper-left corner, by the AxiDraw logo and USB port.

2) Clip a piece of paper to the Clip Easel. (§6.2)
   • Align the paper to the upper left of the Clip Easel, closest to Home.

3) Plug in the power cable and connect the USB. (§7)

4) Using the software, toggle the pen down and back up, leaving it “up”. (§8.4)
   • From the menu, select Extensions > AxiDraw > AxiDraw Control
   • In the “Basic Setup” tab, use the Toggle Up, Down option.

5) Clip in your pen, with height just above the paper. (§8.4)

6) Position your paper with its upper-left corner beneath the tip of the pen. (§8.5)
§9.1, Making your first plot, continued

You are now set up to print. Last thing: Check the area around the AxiDraw, and make sure that the carriage has room to move, both in front of and behind the base.

Finally, switch to the Plot (first) tab of AxiDraw Control, and click Apply to begin.

The AxiDraw should now begin printing your document, and will return back to the Home Corner, with pen up, when it finishes.
9.2 Pausing, resuming, and canceling plots
To pause while plotting, press the pause button, which is the raised button located on the left hand side of the AxiDraw. (See “Detail: Left Base” on page 7.) The AxiDraw will stop plotting and raise the pen immediately after finishing the current line segment.

**Note:** You must physically press the pause button to pause a plot in progress. (The “Cancel” button shown while any Inkscape extension runs is nonfunctional, due to an Inkscape bug.)

Once paused, you can make adjustments in the settings (for example, to the pen height or plotting speed), before resuming. Or, you may simply want to cancel the plot.

To resume a plot underway, use the Resume tab in AxiDraw control, and select the Resume action and Apply:

![AxiDraw Control Resume tab](image)

To return the carriage to the home corner, instead select the “Return to Home Corner” option and Apply. The plot can still be resumed after moving back to HOME (if, and only if, moved by this command).

If you are canceling to start a new plot (from the Plot or Layers tab), you **must** return the carriage to Home before beginning. Failure to do so will cause a loss in position control.

You can also move home manually. To do so, use the “Raise pen, turn off motors” in the Setup tab (See “8.4 Pen up and pen down positions” on page 17), and move the carriage back to the Home Corner by hand. You will need to return home manually in any event where there is a loss of position control.
9.3 Plotting with multiple layers and colors

By default, AxiDraw Control will plot your entire drawing. However, if you have a document with multiple layers, you can use the Layers tab of AxiDraw Control to plot a single layer, or some set of layers.

After plotting from the Layers tab, you can stop to change any settings that you wish to, or switch to a different pen. This makes it possible to plot drawings with portions drawn with different colors and (for example) different speeds.

When you click Apply with the Layers tab open, the AxiDraw will plot only the layer or layers that have a name beginning with the number selected there. The only requirement for using this feature is that you begin each layer name with an integer in the range 0 through 100.

For example, if you have three layers with the names,

1 - Red swirls  
1 - Red zig zags  
2 - Blue circles

Then you can plot the two red layers with a red pen by specifying “1” in the “Plot only layers beginning with” field. You can then change the pen to blue and plot the blue layer by specifying “2” in that field. Click the “Apply” button each time to begin plotting of the selected layers.
Open the Layers window in Inkscape (shown at right) by selecting from the menu: Layer > Layers...

You can edit the layer names within the Layers window, and you can use the various commands in the Layers menu to move objects between layers.

The set of layers shown in this particular example – six layers with six different colors – is for the party invitation example shown below. You can see below how it appears in Inkscape, as well as printed on the page using six ultra-fine point Sharpie markers.

One concern when swapping between pens is to get consistent registration, such that each pen is mounted consistently in the same place. It is easiest to do so when using multiple pens of the same type, and when mounted in the vertical position, rather than in the 45° angled position.
9.4 Basic speed control

The Timing tab of AxiDraw control lets you set the basic movement speeds for the AxiDraw. The two numbers at the top under the “Movement speeds” heading set the speeds used for the horizontal (XY) carriage motion.

![AxiDraw Control Timing Tab](image.png)

The first item in the list, Writing/Drawing speed, sets the maximum speed that will be used when the pen is down. The second, Pen-up movement speed, sets the maximum speed that will be used when the pen is up, traveling between two points.

The default value for these two speeds are 25% and 75%, respectively. You can adjust these speeds. However, please keep in mind that the quality of printing that you can achieve is always a trade-off between speed and neatness.

**Everyday use:**

Most of our sample drawings and tests are made with a medium speed that is a compromise between speed and precision. This is a good balance for fine-point permanent markers and wide-nibbed fountain pens:

- Writing/Drawing speed: 20%
- Pen-up movement speed: 75%

**Working with precision:**

When working with fine point pens and tuning for higher precision (with writing or drawing) a good starting point might be:

- Writing/Drawing speed: 10%
- Pen-up movement speed: 50%

**Working at high speeds:**

When using wide-tipped permanent markers or other writing implements that make broad marks, one might go as high as:

- Writing/Drawing speed: 50%
- Pen-up movement speed: 90%

There are additional factors besides speed that influence precision. These factors include the pen lift and lowering speeds, the weight of your pen, where on the page you are plotting, and so forth. The “right” speed to use for any given application is one that gives you high enough output quality at an acceptable rate.
9.5 Pen lift speeds
The lower half of the Timing tab has the heading “Pen lift and lowering speeds.” These control the vertical motion between the heights that are set in the Setup tab (page 17).

![AxiDraw Control Interface](image)

The four controls in this section allow you to set the:
- The pen raising and lowering speeds, and
- Optional delays (normally set to 0) after raising and lowering the pen.

The pen raising and lowering speeds have units of percent per second. The default speed (150%/s) means that you are asking the motor to move between the 0% and 75% vertical positions in ½ second. It cannot physically move much faster than this, so asking it to move faster than this is rarely helpful. Rather, if you need faster vertical movement, try to decrease the vertical range first, and look at the delays next. Slower, gentler movements are possible, however, and will both lead to neater writing and prolong the life of the motor.

The AxiDraw will pause its horizontal motion while raising or lowering the pen, until the vertical movement is complete. These pauses are meant to prevent the machine from making pen-up movements until the pen is actually clear of the paper, and to prevent pen-down movements from beginning until the pen is touching the paper.

As an advanced option, you can add an additional delay to adjust the behavior one or both of these vertical motions. These additional delays are set in milliseconds, and can be positive or negative in value. (You can use a negative delay value to force the AxiDraw to start its next movement even before the vertical motion is complete.)
9.6 Advanced options
The Options tab of AxiDraw Control has several advanced settings that do not normally need to be changed, but that you may wish to know about.

**Auto-rotate page when printing** (Default: on)
When checked, documents taller than wide (those in portrait orientation) will automatically be rotated sideways. (See page 13 for examples.) Uncheck this box to print documents only in the orientation with which they appear on the screen.

**Use constant speed when pen is down** (Default: off)
When checked, disable acceleration and move the pen only at a constant speed when it is down. This will give neater performance for certain types of paths, but creates more vibration when going around curves. It gives more uniform but less “natural” ink flow.

**Report time elapsed after each plot** (Default: off)
When checked, a dialog box will show elapsed time after each plot finishes.

**Motor resolution** (Default: Super, ~2000 DPI)
The two options are for native resolution of about 1000 or 2000 steps per inch (40 or 80 steps per mm). These do not change the effective resolution of your plot; both are finer than what can be resolved with pens. What is important is that the 1000 DPI option is slightly faster (and much faster when the pen is up), while the 2000 DPI option is slightly smoother, giving a neater plot.
§9.6 Advanced options, continued

Curve smoothing (Default: 10.0)
The curve smoothing factor affects the precision with which curves are interpolated for plotting. The default value of 10 is a good choice for almost all circumstances. Low values (below about 5) may cause smooth curves to appear as a series of straight segments.

Cornering speed factor (Default: 10.0)
When not in constant speed mode, this factor controls how much the machine slows down while going around sharp corners. Higher values cause less slowing down. Moving faster around corners improves speed, while going more slowly improves precision. One of the most noticeable places that this controls is the precision while drawing circles (or letters with circles, such as “O”) while writing text.

9.7 AxiDraw Manual Controls
The Manual tab of AxiDraw Control allows you to manually execute select, basic commands and utilities. Select the operation to perform with the Command drop-down list, and then click the “Apply” button. For the two motor walking commands, you can also specify the distance to move the AxiDraw carriage.
§9.7 AxiDraw Manual Controls, continued

The manual commands are as follows:

**Raise the Pen, Lower the Pen**
These two commands move the pen to the pen-up or pen-down position.

**Walk Carriage (X), or (Y)**
Move (“walk”) the carriage in the X or Y direction by the distance specified. The distances are specified in inches (1 inch = 2.54 cm) and may be positive or negative. The Home Corner is the X=0, Y=0 position, and positive moves in both X and Y are away from the home corner.

An important note is that no limit checking is performed when manually commanding a move from the Manual tab. Take care not to run the AxiDraw into its physical limits. If you are unsure, you can always disable the motors and move the carriage Home by hand.

**Enable Motors, Disable Motors**
These two commands either energize the two stepper motors or turn power off to them. The carriage can only be moved by hand when the power to these motors is off.

**Check EBB Version**
Query the EBB (the AxiDraw control board), and request its firmware version number. AxiDraw is currently shipping with firmware version 2.5.1. (Check EBB Version is one of very few commands that directly requests a response from the EBB; in case of communication difficulties, this command can verify for you that the EBB is talking to your computer.)

If your EBB reports a firmware version older than 2.4.6, we do strongly advise that you update to a newer version. Please visit [http://AxiDraw.com/sw](http://AxiDraw.com/sw) and see the section “Firmware Update”.

**Enter EBB Bootloader Mode**
Command the EBB to enter “bootloader” mode. This utility mode is sometimes used in reprogramming the firmware. If you should accidentally enter this mode, disconnect the AxiDraw from both power and USB to reset it.

**Strip plotter data from file**
The AxiDraw software will store certain configuration data within your document. While having that data there does not cause any known issues, this command can strip that data from the file, should that need arise.
9.8 Plotting away from home
Occasionally, it is the case that the subject that one is writing – for example a name, initials, return address, or signature – is both small compared to a page of paper and needs to be positioned precisely.

One approach is to treat this as a normal page, and to position the text on your document carefully. It can help to place a separate “sacrificial” piece of paper over your workpiece to check if you have your artwork lined up in the right places.

A separate approach is to line up your artwork to the Home Corner in your document, and to place the area of the document where you wish to print right underneath the tip of the pen. For signing the valentine card above – where the entire text consists of two words – one could position the position to start writing (the upper-left corner of the word “me”) directly beneath the pen tip.

Extending this idea further, you can even “plot away from home” by starting out not at the home corner, but from some midway point (a “virtual” home corner) where the pen can reach to other parts of the document. For example, one could manually walk the carriage to X=3 inches, and you could use that as the starting point for your plot. After each plot, the carriage would return home to that position. Use great care, however, that your drawing does not exceed the now more limited range available from that position.
10: Designing for AxiDraw

10.1 General considerations

The AxiDraw is a pen potter, which is fundamentally a single function device. Its sole function is to guide a pen (or other implement mounted in the pen holder) along the set of vector lines, curves, and paths that you ask it to follow. All other things that the machine is ultimately capable of – such as drawing graphics, writing text, or signing documents – are expressions of this basic function. It is capable of drawing essentially anything that can be composed from a set of lines.

Certain object types are automatically treated as paths, for example circles and rectangles. Other types of objects that are made of curves – like text – may need to be converted from (editable) text into simple paths before plotting. You can convert a selected object to a path by using the menu option Path > Object to Path.

When designing in Inkscape, it is recommended to create new documents by using an A4 or US Letter sized template. You can create a file from a template by selecting File > Templates, and then selecting A4, A4 Landscape, Letter, or Letter Landscape.

Objects that are not paths

The AxiDraw does not directly plot objects that are not made of paths. This includes pictures (raster or bitmap images, such as .jpg, .gif, .png files), and effects such as fills, gradients, and background colors. These kinds of things require conversion to paths before plotting. That is straightforward in some cases, and not in others. For example, solid fills are easy, using the Hatch Fill extension included with the AxiDraw software.

Importing graphics

The native file format of the AxiDraw is SVG (“scalable vector graphics” – a standard interchange format). You can create artwork directly in Inkscape. However, many other graphics programs including Adobe Illustrator and CorelDRAW can export SVG directly. Inkscape can also import artwork in formats including .eps, .dxf, .ai, .cdr, .pdf, and others.

It is worth noting that the file type itself is not always a reliable indicator of whether or not the file suitable for use on the AxiDraw. For example, a PDF document with text from Adobe Illustrator will generally work very well, but it is also possible to create a PDF that contains nothing but a picture in JPG format. In the latter case, the image still isn’t vector graphics, even though it’s tucked into a PDF file.
10.2 Visualizing paths in your document
To see all of the paths in your document, select all in your drawing (Edit menu > Select all in all layers). Then, open the Fill and Stroke panel (Object menu > Fill and stroke).

In the Fill tab, select “No paint” (the “X”). In the Stroke Paint tab, select “Flat Color”. And, in the Stroke Style tab, select a consistent width, say 0.020 inches or 0.5 mm.

This procedure generally provides a good preview of how the AxiDraw will view your page. It is only a preview however; it shows the outlines around objects even if they are not (for example with text) converted to paths yet.

10.3 Working with standard fonts
Most fonts (e.g., truetype, opentype fonts) that are installed on your computer will be accessible from the text layout tools directly from within Inkscape. You can use fonts in any style or character set— including foreign languages and including fonts that resemble handwriting.

This example was made using the font “Savoye LET” on a Mac.
To convert your editable text into paths that can be plotted, select them and choose from the menu Path > Object to Path. You may wish to save a separate copy of your document before converting to paths, in case you wish to edit the text again later.

All standard fonts are outline fonts (see the next section about stroke fonts for more about that). This means that when you do convert it to a path, it produces a hollow outline that your pen can follow. Here are two text examples, showing how different that might look with Helvetica Neue Ultralight and Trebuchet MS Regular:

Using fonts that have a relatively thin and constant stroke width can hide the fact that the pen is tracing the outline, as your pen strokes will overlap when drawing along the two edges. Some degree of outlining is usually acceptable, particularly when using wider pen tips that produce wider lines. If you instead desire filled-in text – for example that Trebuchet MS example filled in fully black – you will need to fill it in, using the Hatch Fill extension (See “10.7 Filling text and shapes” on page 38).

When trying to achieve an effect closer to that of natural handwriting, an “outlined” effect is generally not acceptable. Pick handwriting-like fonts that have a thin and relatively consistent stroke width. Using a medium nib fountain pen (with its relatively wide stroke) can help to hide artifacts as well. It is also helpful to pick a larger font size, closer to natural handwriting (perhaps 18 pt) as a starting point.

If you would like to create a custom handwriting font based on your own handwriting, there are free services online (such as http://calligraphr.com) that can build fonts based on samples that you provide. If you create several handwriting fonts through the same process, you can alternate between them in order to introduce more variation between the letter shapes within a single document. However, do note that these are standard (outline) fonts, and the advice above still applies.
10.4 Single stroke fonts & Hershey Text
The ideal type of font to use with a plotter is an engraving font or single stroke font.

Standard fonts used on computers (truetype, postscript, opentype, etc.) are outline fonts. In these, the font file describes a filled vector shape. That is to say, the visible part of a character in an outline font is the area enclosed by the shape. Fonts like these are the best possible choice for use in laser printers or other high-resolution devices.

By contrast, an engraving font (sometimes called a “stroke” font) is one where each visible character is defined by the stroke itself, not the area enclosed by it. Fonts like these are the best possible choice for pen plotters. However, most graphics programs are only capable of understanding outline fonts, and so these are relatively rare.

Inkscape includes an extension that we developed called Hershey Text, which can create short snippets of stroke-based text in a few different fonts. The text is created directly as vector paths, rather than as editable text.

Hershey Text can be found in the menu at: Extensions > Render > Hershey Text. You can read a full introduction to Hershey Text at: http://www.evilmadscientist.com/go/hershey

Additionally, we are currently developing a new piece of software called “Hershey Text Advanced,” which can convert a full page of paragraph text into stroke fonts, using the same mechanisms. It is available in beta to AxiDraw users. If you would like early access to this software, please contact us directly: https://shop.evilmadscientist.com/contact

Links to many other sources of single stroke fonts can be found at the IJ instruments Single Line Fonts page (Short URL: http://bit.ly/1SweD6c )
10.5 Capturing signatures and handwriting

The best way to transform some handwritten text — whether a signature or a full page of text — into something that the AxiDraw can plot is to use direct handwriting capture, or what you might refer to as “real-time” capture.

In direct capture, you use your computer to record each stroke as it is written, and then save the resulting set of paths as a vector artwork file. This method can also be used when replicating handwriting. For example when replicating historical signatures, it is necessary to trace along the strokes of existing writing and to capture those strokes as you trace them.

For much more about ways to capture and trace handwriting — including a link to jSignature, a program that can easily capture your signature in real time — please see our detailed documentation on the subject:

http://wiki.evilmadscientist.com/capture

A link to this page can also be found on our main documentation site,

http://axidraw.com/docs

10.6 Aside: On automatic tracing of handwriting

While we are frequently asked about this, it should be noted that there is not any straightforward way of transforming scanned handwriting into a set of high-quality vector paths that a pen plotter such as the AxiDraw can follow. Simple approaches such as centerline tracing rarely approximate the quality and character of real human handwriting.

This is a longstanding problem in artificial intelligence called “handwriting trajectory reconstruction.” Solving it is well outside of what the AxiDraw software aims to support. (Again, the function of the AxiDraw is to plot the vectors that you supply to it.)

When software that performs handwriting trajectory reconstruction comes to exist some day (and we expect that it will), the AxiDraw will be here, ready to plot its output.
10.7 Filling text and shapes
The AxiDraw software includes a second Inkscape extension, which handles the task of filling in areas with paths, such that they can be filled in with pen strokes on your page. You can find it in the menu at Extensions > AxiDraw > Hatch Fill

Hatch Fill will fill any selected objects with a series of back and forth lines, with adjustable spacing and angle. The hatch spacing is measure in units of screen pixels (px), and the default value of 5.0 is appropriate for wide permanent markers. A lower spacing will produce a more uniform fill, and a higher spacing will produce a more traditional hatch fill for shading. You can use the “Live preview” option to see the effects of different choices without actually applying them to your shapes and text.

The “Connect nearby ends” option (enabled by default) connects the ends of the hatch lines to make long wiggling paths that plot very efficiently. An additional option is provided for insetting the fill from the edges. This helps to avoid “coloring outside the lines” when using the hatch fill.
11: Maintenance and troubleshooting

The AxiDraw should not require any regular maintenance under normal conditions.

11.1 The hex wrenches
Several hex wrenches are included with the AxiDraw. One of these – the ball-end 5/64” (2 mm) wrench – is used for switching the pen between the vertical and angled orientations. The other wrenches are provided “just in case,” and should not be needed in most circumstances. However, if something should come loose, you should have the right tools on hand to tighten it.

11.2 Lubrication
The X carriage contains 8 linear ball bearing modules that allow the X shafts and Y shafts to slide. They have rubber seals that prevent dust and dirt from entering the ball bearing mechanisms. To ensure free movement of the carriage and to prevent corrosion of the shafts, they are lightly oiled before shipping. They generally do not require added lubrication under normal use.

Under heavy use, it may sometimes be necessary to re-oil the shafts. If the motion starts to sound or feel rougher or more grainy, lubrication is probably needed. Use a light lubricating oil such as “3-in-1” or sewing machine oil. Put one drop on a fingertip and rub it along the entire length of the shaft until the carriage moves freely. Only a very small amount is needed.

Do not lubricate the pen-lift (vertical) slide mechanism. Its stainless steel shafts do not require corrosion protection, and the vertical bearings (plain bearings machined from a Teflon/acetal composite) will not slide freely if oiled.

11.3 Belt tension
The AxiDraw uses a single timing belt, looped in an “X” around the two motors and the Y carriage. This belt may gradually stretch a small amount, and can be re-tensioned where it is anchored, if necessary. Do not retension the belt unless it is actually necessary to do so.

11.4 Loss of position
The most significant thing that can go wrong under normal operation is a loss of position control while the carriage is moving. This is typically manifested as a loud grinding or screeching noise. It can happen when moving at too high of a speed, or when the carriage hits an unexpected obstacle – for example if it was not moved to the Home Corner before plotting or if it was bumped while moving.

If this should happen, press the pause button as soon as possible to cancel the plot. Remove power to the machine if necessary. Use “Raise pen, turn off motors” in the setup tab to de-energize the motors, and manually return the carriage to the Home Corner before trying to plot again. As a sanity check, the carriage should return exactly to the Home Corner when a plot is finished.
11.5 Service, repair, and parts support
The AxiDraw is designed to be serviceable, and we are here to help. Nothing should require regular replacement. However, most parts of the machine can be unscrewed and replaced if necessary. Please contact technical support directly if you need assistance with troubleshooting or repairing a mechanical issue.

12. AxiDraw Tips and Tricks

1. It is often possible to get better print quality on top of a small stack of paper (say, 5-10 sheets) which gives a little cushion to your writing.
2. High quality paper – especially paper designed for use with pens – tends to give dramatically better results with pens than does cheap copy/laser paper. Bristol paper with a smooth finish is a great example of a paper designed to work well with pens.
3. The flatter that your paper is held, the better your print quality will be. Paper that is warped or “bubbled” will flex as the pen writes, leading to distortion. When the bubbles or warping are tall enough, it can also lead to stray marks on your page during pen-up movements.
4. Reducing the amount of vertical pen travel that is needed will also improve print quality, since the pen-lift servo motor does introduce vibration.
5. If the motors do not move but (1) everything looks correct, and (2) your computer doesn’t report any errors, triple check that the 9 V power supply is plugged into a working outlet.
6. When making multiple-color plots, you can get better registration when switching pens by making sure that each pen is set to the same height above the paper. A good way to do this is to rest the tip of the pen on a spacer when tightening the pen in place. Use a small, flat piece of wood, plastic, or metal. (A good example might be a thin bottle cap, or a stack of two coins.)
7. Clean the AxiDraw only with a soft, clean cloth. The non-electronic metal parts may be cleaned with a cloth moistened with soap and water if needed. Avoid other cleaners and solvents. The X and Y shafts and bearings are oiled and are be susceptible to corrosion if the grease is removed. Do not wet the motors, cables, or controller board.
8. It is possible to completely detach the AxiDraw’s pen holder, and affix other types of tools to the front of the Y carriage. Four tapped holes are provided for mounting other types of tool heads there.
9. Certain types of pens can “dry up” if left in the pen-up position for a minute or two. This can lead to an awkward situation where ink does not start flowing until after the machine has already been drawing for a bit. When working with pens like this, it may be helpful to “bleed” out the tip with a bit of scratch paper before printing.
9. A single rubber band can be looped loosely around the pen holder as shown, to add a small amount of additional pressure for use with ball-point pens, or for operating the AxiDraw in other orientations (when gravity is not readily available to pull the pen to the surface). Do not add a rubber band unless it is actually needed; it will reduce the lifespan of the pen-lift servo motor. Example rubber bands are included with the AxiDraw, but will degrade over time.

10. If your motor wires should become disconnected at some point, here is where they go. Left motor: “Motor 2” locations, red, yellow, green, gray (from top to bottom). Right motor: Motor 1 (same order). Servo cable: B1 (lowest three pins on left hand side), with black wire towards the edge of the board.

Online documentation & resources for AxiDraw: axidraw.com/docs